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This manual is © 2020, Jo Montgomery.

This manual is distributed under the creative commons Attribution-Non-Commercial-Share Alike 2.0 licence.  This means that you are free:

1. to copy, distribute, display, and perform the work

1. to make derivative works

Under the following conditions:

· Attribution. You must give the original author credit.

· Non-Commercial. You may not use this work for commercial purposes.

· Share Alike. If you alter, transform, or build upon this work, you may distribute the resulting work only under a licence identical to this one.

Please note that:

1. For any reuse or distribution, you must make clear to others the licence terms of this work.
1. Any of these conditions can be waived if you get permission from the copyright holder.
1. Nothing in this license impairs or restricts the author's moral rights.

Full details of this licence can be found at 
http://creativecommons.org/licenses/by-nc-sa/2.0/uk/legalcode
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[bookmark: _Toc10634876]Laboratory Notebooks
[bookmark: _Toc10634877]Expectations and responsibilities
Before we start, a few words on the legal responsibilities about recording our research. We need to:
· Document what we are doing
· Be able to find results
· Our records need to be timely/traceable/retrievable
· Checked
Policies can be found on the intranet www.campus.babraham.ac.uk
Follow links to:
	>Quality Assurance of Research (QAR)
	>To read the Babraham Institute Guidelines for the use of laboratory notebooks click here

The purpose of a lab book is to document what we are doing and should include:
· date and initials, 
· experiment number
· Comprehensive record
· clear and accurate records
· Data is retrievable
· Kept securely
· 10 years
· It should also be checked by your line manager every two weeks – this is much easier with an electronic notebook.
Lab books are changing. Old paper lab books are no longer fit for purpose – today’s research produces too many documents, data is too big and is most often created as digital/electronic files. 
We need a new way.

[bookmark: _Toc10634878]Why OneNote?
· Digital Notebook
· Gathers notes – handwritten or typed – drawings, screen clippings, images and audio content
· Notes can be shared

OneNote is the nearest equivalent to a paper notebook
· It’s a note taking app, not a bespoke lab book but…it is flexible– it allows for different structures, different projects/groups/ways of working
· Allows us to include data from a range of sources
· Not prescriptive
· Microsoft – so it should be well supported and have future longevity (unlike other smaller, bespoke offerings)
· Safe, compliant storage (more on this later)



[bookmark: _Toc10634879]About OneNote
OneNote is not a single entity. There are different versions and different platforms with different features and functionality depending on the platform/version.

Currently, OneNote 2016 has the most features/functionality but is being ‘sunsetted’ – Microsoft are no longer developing and are tailing off support. It is a dead product.

OneNote for Windows 10 is now being developed and new features are being added all the time. At the moment it is a basic version similar to OneNote online and the mac version.

The thinking is that in the future, the functionality will be more similar across platforms. OneNote10 has the same appearance as the mac and online versions, which look different to OneNote 2016. OneNote 10 is likely to be a wrap-around app so other versions will be broadly similar.

Today we’ll be looking at OneNote Online – it is completely cross platform and accessible from anywhere. It is our current universal framework.

You don’t need the additional features in OneNote2016 but you can always open your OneNote Online notebooks in OneNote 2016 if you have it on your computer and you’re used to working in that version.


[bookmark: _Toc10634880]OneNote online

[image: ]
If your computer has already been upgraded to Windows 10, you may also have the version of OneNote10 as well as OneNote 2016 (both versions remain on your machine), or you can request computing to install OneNote10.

If you’re a mac user then the online version is very similar to OneNote for macs.

Although the online version is accessible anywhere and works across platform, it does have more limited functionality at the moment and can be slow.

[bookmark: _Toc10634881]Storing and saving notebooks
OneNote2016 offers the possibility of saving your notebooks to your local drives (computer or network). The online version and mac version cannot be stored to local drives; notebooks must be saved online or in cloud storage.

The BI computing-supported storage area is the ELN – Electronic Laboratory Notebook area on SharePoint.

This is BI controlled and data is stored within UK as legally required.
It is automatically synced, so you don’t need to worry about saving.
It’s also backed up locally onsite daily. 

This is the safest way of keeping your data. We do not support storing it on local drives or using drop box/googledrive etc.

[bookmark: _Toc10634882]The Electronic laboratory Notebook (ELN) area on SharePoint
Let’s start at the ELN as this is where data will reside.
[bookmark: _Toc10634883]Setting up the ELN
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https://babraham.sharepoint.com/sites/ELN/SitePages/Home.aspx
or go to Office.com and search Sharepoint/ELN






If you wish to have a collaborative Electronic Laboratory Notebook (ELN), group leaders will need to request computing to set up a Group ELN on SharePoint. This Group ELN has a “document library”. Sub-folders can be put in here, owned by individual members of the group, and sharing preferences set up to allow collaboration, read only, read-write permissions as required. Individual members can have multiple notebooks in their folder.

You can copy an existing notebook into the ELN by making a new notebook and copying it in section by section – this is computing’s recommended safest way. Create a local backup before you start copying and moving.

You can link the desktop and ELN version and it will sync and keep up to date. Whenever changes are made, it will be saved to the OneNote version, or rather cached as an offline version ‘backup’ on the computer and then immediately saved/synced to OneDrive/Sharepoint. 

If you don’t want to, you never have to look at Office 365/OneDrive/ELN site ever again once you’ve opened your notebook on the ELN for the first time and then clicked “Open with OneNote”.  It will then be available to open through your desktop version of OneNote but will sync through to the ELN. Those group members with access to/collaborating with your notebook will still need to access it through the ELN.

[bookmark: _Toc10634884]ELN structure
Go to the ELN area of SharePoint.

https://babraham.sharepoint.com/sites/ELN/SitePages/Home.aspx
or go to Office.com and search Sharepoint/ELN

Click on Group leader’s initials in the top left (eg JM).
This takes you to the Lab Notebooks repository.

Find your folder (your initials).

Your laboratory notebooks are stored in this folder.

You may only see your folder, or you may see the folders of your group members, depending on the sharing permissions you and your group have set up.
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[bookmark: _Toc10634885]Opening a OneNote notebook
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Once a notebook has launched in OneNote online, you can click on ‘open in OneNote’ at the top of the screen here – to open in either 2016 or the Windows 10 version if you have this installed, or you can stay online.

We will be using the online, or office 365, version here to maintain similarity and functionality across platforms.

[bookmark: _Toc10634887]Storage and organisational structure of OneNote
Let’s take a step back from the software for a minute and think about storage and organisation.
There is a hierarchy to the structure of a OneNote notebook – different levels of organisation.
We’ll look at the hierarchical structure, then we will look at the operational tools to use OneNote and then come back to suggest ways to use the structure specifically to make a laboratory notebook.

Notebooks are stored in SharePoint – in the ELN area.

Each group member can have multiple notebooks.
Each notebook can then be further divided into sections (tabs)
Each section can then have multiple pages.
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Getting started
The first tip is to pin the drop down menu so it stays there.
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[bookmark: _Toc10634889]What is a page?
A page in OneNote is not like a word document; it is just like a sheet of paper you can write, draw and scribble on – anywhere within that page.
You are not required to work top to bottom or left to right.
It is an (almost) infinitely sized piece of ‘paper’ in which you can have whatever structure you like.
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[bookmark: _Toc10634890]Add sections and pages
[bookmark: _Toc10634891]Sections or tabs
Add a New Section/Folder/tab by clicking on the + Section tab
You can also add pages to a Notebook Section/Folder/tab by clicking on the +Add Page function at the left hand side of the window.
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When you click on + Section, a Section name dialogue box pops up.

[image: ]
Or you can right-click to rename the section.
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You can change the colour of the section/tab – which can be useful to colour code experiment types etc.
Right click on the section tab and select Section Color.
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You can rearrange the order of sections/tabs.
Click and drag sections into the order you want.
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[bookmark: _Toc10634892]Pages
Page order can also be rearranged.

At the top of each page, there is space for a title or page name.
Add a title here and it automatically becomes the name of that page (you’ll see it appear on the left hand side of the screen)
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Sub-pages
There are additional levels of organisation or indentation – subpages.
Add subpages by right clicking on a page and selecting make sub page. You cannot make a sub page without there being another page above it.
You can even make sub-sub pages.
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What can you do in OneNote?
We’ll look at some of the functions of OneNote.
· Add text
· Make tables
· Insert images
· Insert/attach files
· Add links

There are also other functions in OneNote that aren’t relevant to a laboratory notebook, such as stickers and emojis! You don’t need to use these.

[bookmark: _Toc10634894]How to add things in OneNote
You add things simply by clicking on an appropriate place in the notebook and using the relevant insert tool.

NB Things don’t move out of the way/move down automatically, so make sure you add top to bottom (mostly) and that there’s enough space. 

You can pick up objects/text boxes etc. and move them around later in you need to.
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[bookmark: _Toc10634895]Text
Click anywhere on the page to begin typing.
Text appears in text boxes which you can move around.
[image: ]You can format text and styles.


















[bookmark: _Toc10634896]Tables
Make tables automatically. 
Just hit the Tab button to turn what you’ve just typed into the first cell of a table. 
Delineate further columns with Tab, and just press Enter to start filling in the next line.
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[bookmark: _Toc10634897]Images
You can insert pictures from files or the internet.
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Or use snip or grab tools and then use Control + V to paste in (Command + V on a mac) – right click copy and paste doesn’t work within OneNote.
[bookmark: _Toc10634898]Add files
You can add files in two ways:
1. As an attachment
a. it will add/embed all file types. 
b. You just see the file icon, it will open elsewhere (eg. Excel)
c. You can also drag and drop files to embed

2. As a file printout
a. You can include a file in your one note notebook using Insert > File Printout and navigating to the file you wish to include
b. It gives you the file icon but also a pdf-like display/view of the file inside your notebook.
c. You can only add word or pdf files as a file printout (in the online version).
d. (in OneNote2016 you can add other file types eg. Excel)
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[bookmark: _Toc10634899]Add links
You can add hyperlinks to your notebook to link to webpages or to other pages, sections or notebooks (just copy the URL for the page/section/notebook).

Go to Insert > Link and then you can add the text you’d like to display along with the actual web address.

Just copy the URL for the page you want and type the text you would like to appear to create a hyperlink.

For data stored on websites, such as Sierra, you can create a hyperlink. 
We need to think about what to do regarding large datasets which are too big to insert into OneNote, but be mindful of the legal requirements for data to be retrievable (more on specific data types later).
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You cannot make a direct link to where files are stored elsewhere as it tries to make the file path into a URL. There are two ways to include information on file stored elsewhere:
1. You can simply report the location of where files/data is stored.
Give file location:
· Shift + Right Click on file in finder > copy as path
· Paste text into OneNote as a record of where the file is stored
· Make sure the file location doesn’t change
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This inserts a copy of the file location – but not a link.
It is simply a record of where your data is stored.

2. You could turn this path into a URL (but not a dynamic link).
· Remove ‘http’ and type ‘file://’ at the start, remove all backslashes (\) and replace with forward slashes (/). If you have spaces in your file names, you will also need to replace the spaces with %20
· Not a dynamic link
· Copy this link into browser and it should go to the file location

[bookmark: _Toc10634900]Other useful stuff
[bookmark: _Toc10634901]Draw
Go to the Draw menu to choose a pen and draw with your mouse, or finger/stylus on a touch screen.
You can use this to draw freehand on the screen.
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Or annotate slides and notes, or annotate gel images etc.
[image: ]
However, be aware that the image and annotations or text are not ‘grouped’ so could become dissociated (especially if you move things around). Many find it easier - especially if you are labelling - to annotate in a different programme, e.g. Powerpoint, and then insert the compound image.

You can type in a text box and then move it over the image, change font colour/size etc as appropriate, but the same issues exist – the text and image are not ‘grouped’ so can move independently.

Remember that the high quality is not be preserved when you insert an image into OneNote so you’ll need to store the original image somewhere and note how and where to find it as well. Images in OneNote should be for reference only.

[bookmark: _Toc10634902]To do lists and tags
Add a to do list, mark as done, flag for follow up, mark as important, a question , an idea etc…
There are many tags to choose from.
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[bookmark: _Toc10634903]Add a Time and date stamp
The date of when you start a page/ notebook is automatically added, but in OneNote 2016 you can also add a Time and Date stamp at any point (just as you might in a paper lab book). This tool doesn’t exist in other versions, but you can obviously type in the date and time. A digital stamp of date and author is automatically recorded by OneNote (see ‘versions’ later).
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[bookmark: _Toc10634904]Audio and video
You can also add audio or video recordings, if you have the technology to capture it. This may be a more useful feature if using OneNote on your smart phone or tablet. 
OneNote cannot transcribe audio recordings into text, but if you take the audio recording in OneNote (rather than importing it) it is able to search for terms within that recording and point to where it found them - but this does require the audio file to be indexed first, which can take a very long time (not recommended).

[bookmark: _Toc10634905]Table of contents
Create  a Table of Contents with Links
· OneNote2016: Insert > Link > My Notebook
	and navigate through the Sections/pages to add
· OneNote 2016, 10 and mac – use double square brackets around page title to create a dynamic link eg. [[pagetitleofexistingpage]] (not in OneNote online) 
· OneNote Online – copy URL for notebook/section/page and add this as a link
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Copy the URL for the page/section/notebook you wish to link to, then paste into the address bar.

[bookmark: _Toc10634906]Page backgrounds, templates and gridlines
OneNote 2016 has a range of templates (including backgrounds but also different formatting, eg for lecture notes or meeting minutes, as well as the option to add lines or grids. However, typed text does not align to the lines or grids.

OneNote for mac:
Lines etc. can be found in View > Paper Style
You can change the page colour on a mac, but there are no page templates. 
This is not a function in OneNote online!
As with other features, if you have added them in the OneNote 2016 or mac versions, they are hidden when viewing in the browser/online version, but are preserved.
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[bookmark: _Toc10634907]Indents and outdents
You can quickly and easily indent and outdent text or rearrange the order in a list using 
Alt + Shift + arrow keys. 
(Option + command + arrow keys on a mac).

[bookmark: _Toc10634908]Translation
Don’t bother with the translation tool! It simply sends text over the internet to a third party translation service (and isn't very effective!)
If you must use an auto-translator then I would suggest copying the text and running directly in a translation service of your choice - with the usual cautions!

[bookmark: _Toc10634909]Maths functions
These work best in OneNote 10.
You can also insert pre-made equations in OneNote 2016.
The Mac version will turn typed text into mathematical text eg. curly.
OneNote Online doesn’t have these functions.
Search text
Type in the search box (magnifying glass icon at top of menu on left hand side)
This brings up a window and asks if you want to search a page or a section but there is no option to search an entire notebook.
(Ctrl +F also allows you to search current section or page but not the entire notebook)
[image: ]










[image: ]















Search text in an image
OneNote 2016:
Search anywhere—even in images. You can right click on any image and select “Make text in image searchable.” From then on, when you search for text, the image will show up in the results. This is great for methods sections of scanned papers from the 1940s, but probably has few other uses.
Not in OneNote online, OneNote 10 or mac!

[bookmark: _Toc10634911]References
OneNote is not a reference management system
You can link to a reference management system such as Reference Manager or EndNote if you must
You can also include hyperlinks to papers or files, or attach files.

[bookmark: _Toc10634912]Sharing a OneNote notebook
[bookmark: _Toc10634913]Who can see your lab book?
Your group leader and group members may be able to see your notebooks on the ELN – depending on the permissions you have enabled: read or read-write access to your notebooks.
You can also share notebooks with people outside your group by share, invite people or sending a link
This sharing link only works within BI (from OneNote Online or OneNote 2016 shared on SharePoint) – check with computing if you need to configure external sharing.

If it’s stored on OneDrive (although storing on ELN on SharePoint is recommended by computing) you can share externally.
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[bookmark: _Toc10634914]Versions
Right click on a page and select show versions.
This can tell you modifications/versions made with dates and authors. This can be really useful for collaborative notebooks and also for supervisors/PIs to add comments or check and sign-off.
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It shows the date when entered and the author.
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[bookmark: _Toc10634915]Suggestions for use as a laboratory notebook
Each main project is a notebook – you can span more than one year this way (although others set up a notebook for each year and have separate projects as tabs – you need to find what works for you and your group).

Each Section tab can be a technique, mouse strain or a sub-project, depending on the nature of your research.

Having a standard protocol Section tab can be a good idea – then you can link to it whenever you use that protocol and not have to write it out repeatedly. Or you could have a group protocols notebook and link to this.
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Take a look at this example laboratory notebook (link below), see how data is added and sections are organised etc. This is just an example. Your laboratory notebook needs to be flexible for you, your research and your group, so find the best set-up for you.

https://babraham.sharepoint.com/:o:/s/ELN/JM/EukJeoh_7qFFlhWye9y5K6QBtxshmDPJTPzk7kNN0eXYQg?e=ZZlyMR

[bookmark: _Toc10634916]


Features
[bookmark: _Toc10634917]Table of contents
You may wish to use hyperlinks to include a table of contents in your Notebook
[image: ]

[bookmark: _Toc10634918]Project overview
You could include a project plan, timeline and to-do list, including thoughts and notes for manuscripts etc.
[image: ]

[bookmark: _Toc10634919]Protocols
You may find it useful to keep all protocols in one section/tab. You can have them written out in full or as file attachments or file printouts. If you share standard protocols across the group, then perhaps having a designated laboratory notebook just for protocols would be useful – you can then link to the relevant notebook/section/page.
[image: ]
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[bookmark: _Toc10634920]Experimental Results
You can include methods and results in ‘experiment’ sections/tabs and pages, including screen snips of some results, graphs and images (see Data).
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[bookmark: _Toc10634921]Data
Your data needs to be comprehensively recorded, timely and retrievable. Depending on the nature and size of data, there are a number of ways to input this in OneNote:
· Attach a file or file printout – OK for smaller files (<19MB) 
If you amend the original file, it doesn't update. This is like sticking in a physical copy into a paper notebook
· You can add a link to a file - but if this file moves then the link will no longer work. 
· With bigger datasets such as sequencing or imaging, you can link to the file store - these have their own storage and archiving systems and will be maintained
· Or just reference where in Sierra etc in the notebook
· Create a non-dynamic link referencing a storage location using copy as path 
"O:\Training\One Note\test PDF.pdf" 
· Use screen shots to document what you've done 
Sequencing data
Sequencing files are too big to embed in OneNote. 

· You could create a master list and standard storage location for sequencing experiments and note this location in your OneNote notebook
· You could create a link to sequencing LIMS
· You can link to Sierra, although the person reading would need Sierra log-in access, or you could just reference where it is stored – for example using copy as path to include the file location
· It may also be useful to include a few screenshots to aid explanation and understanding – but don’t include every step of analysis


[image: ]

Imaging data
Imaging data can be very large, so don’t include in OneNote – reference the storage location.

· A direct link may not be a good idea due to accessibility / retrievability issues
· The Babraham imaging facility keeps files in an easy access file storage for 1 year, in individual users’ folders. After this, they are archived to a longer term storage area, using the same storage structure
· You may wish to include a screenshot for narrative purposes, but a high resolution version should be stored elsewhere and the location documented
· You may wish to annotate images in another program and then insert into OneNote to avoid text/annotations and the image becoming dissociated

[image: ]

Flow data
If files are small, they can be inserted into OneNote.

Data from cytometers (.fcs files) – you can link to or reference where this is stored
Sorts (PDF) of the sorting gates and sorting statistics are small and can be inserted or attached as a file printout in OneNote, or you can link to or reference where data is stored.

Screenshots may be useful for narrative purposes. 

[image: ]

[bookmark: _Toc10634922]

What’s next?
Have a go at creating your own laboratory notebook with a layout that works for you and your research.

[bookmark: _Toc10634923]Further help
· https://support.office.com has lots of quick, short video tutorials
· Contact computing to set up SharePoint ELN area
· http://www.bioinformatics.babraham.ac.uk/training.html 
· babraham.bioinformatics@babraham.ac.uk 
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